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About This Document

This document explains how to install, configure, and deploy the BEA WebLogic
Adapter for PeopleSoft 8 for WebLogic Integration 2.1, which is used to develop
online connections to PeopleSoft 8 applications.

This document is organized as follows:

Chapter 1, “Installing the Adapter for WebLogic Integration 2.1,” directs users to
the information they need before installing the BEA WebLogic Adapter for
PeopleSoft 8 and describes how to install the adapter.

Chapter 2, “Installing and Compiling the Component Interfaces,” describes how
to install and compile the component interfaces.

Chapter 3, “Installing and Configuring the BEA TCP/IP Message
Router,”describes how to install and configure the BEA TCP/IP Handler to
enable PeopleSoft 8 event functionality.
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Audience

This document is written for system integrators who develop client interfaces between
PeopleSoft 8 and other applications. It describes how to install and deploy the BEA
WebLogic Adapter for PeopleSoft 8 and how to use it with WebLogic Integration and
adapter tools to develop online connections to PeopleSoft applications. It is assumed
that readers know Web technologies and have a general understanding of Microsoft
Windows and UNIX systems as well as:

General knowledge of the PeopleSoft environment, including Application
Designer and PeopleTools.

General knowledge of PeopleSoft Application Messaging and PeopleSoft
Component Interface.

Business application knowledge in some specific application area.

Knowledge of PeopleSoft 8 processes and data model for the required
application area.

General knowledge of WebLogic Integration architecture.

General knowledge of client-server concepts.

Related Information

The BEA corporate Web site (www.bea.com) provides all documentation for
WebLogic Server and WebLogic Integration. For information about these products, go
to http://e-docs.bea.com. Documents that you may find helpful when installing
the BEA WebLogic Adapter for PeopleSoft 8 are:

BEA WebLogic Adapter for PeopleSoft 8 User Guide

BEA Application Explorer Installation Guide
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BEA WebLogic Server 6.1 installation and user documentation, which is
available at the following URL:

http://edocs.bea.com/wls/docs61/index.html

BEA WebLogic Integration 2.1 installation and user documentation, which is
available at the following URL:

http://edocs.bea.com/wlintegration/v2_1sp/index.html

PeopleSoft 8 Documentation, available online or on CD-ROM. The following
components are applicable:

PeopleSoft Component Interface

PeopleSoft Internet Architecture Administration

PeopleSoft Application Messaging

Contact Us!

Your feedback on the BEA WebLogic Adapter for PeopleSoft 8 documentation is
important to us. Send us e-mail at docsupport@bea.com if you have questions or
comments. Your comments will be reviewed directly by the BEA professionals who
create and update the BEA WebLogic Adapter for PeopleSoft 8 documentation.

In your e-mail message, please indicate which version of the BEA WebLogic Adapter
for PeopleSoft 8 documentation you are using.

If you have any questions about this version of BEA WebLogic Adapter for PeopleSoft
8, or if you have problems installing and running BEA WebLogic Adapter for
PeopleSoft 8, contact BEA Customer Support through BEA WebSupport at
www.bea.com. You can also contact Customer Support by using the contact
information provided on the Customer Support Card, which is included in the product
package.

When contacting Customer Support, be prepared to provide the following information:

Your name, e-mail address, phone number, and fax number

Your company name and company address
BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide vii



Your machine type and authorization codes

The name and version of the product you are using

A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text Indicates terms defined in the glossary.

Ctrl+Tab Indicates that you must press two or more keys simultaneously.

italics Indicates emphasis or book titles.

monospace
text

Indicates code samples, commands and their options, data structures and
their members, data types, directories, and file names and their extensions.
Monospace text also indicates text that you must enter from the keyboard.

Examples:

#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace
boldface
text

Identifies significant words in code.

Example:

void commit ( )

monospace
italic
text

Identifies variables in code.

Example:

String expr
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UPPERCASE
TEXT

Indicates device names, environment variables, and logical operators.

Examples:

LPT1

SIGNON

OR

{ } Indicates a set of choices in a syntax line. The braces themselves should
never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should
never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]...
[-l file-list]...

| Separates mutually exclusive choices in a syntax line. The symbol itself
should never be typed.

... Indicates one of the following in a command line:

That an argument can be repeated several times in a command line

That the statement omits additional optional arguments

That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]...
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line.
The vertical ellipsis itself should never be typed.

Convention Item
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CHAPTER
1 Installing the Adapter 
for WebLogic 
Integration 2.1 

This section provides instructions for installing the BEA WebLogic Adapter for
PeopleSoft 8 with WebLogic Integration. It includes the following topics:

Before Installing the Adapter

Understanding the Representation of Paths

Step 1. Obtaining the BEA WebLogic Adapter for PeopleSoft 8

Step 2. Extracting JARs and Adjusting the Classpath

Step 3. Configuring the WebLogic Integration Database for the Domain

Step 4. Replacing the xmltoolkit.jar File

Step 5. Updating the BEA License

Step 6. Deploying the Adapter Using the WebLogic Server Console

Step 7. Adding the Administrative Server User Name to the Adapter Group

Next Steps
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1 Installing the Adapter for WebLogic Integration 2.1
Before Installing the Adapter

Before you install the BEA WebLogic Adapter for PeopleSoft 8, you must review the
BEA WebLogic Adapter for PeopleSoft 8 Release Notes to ensure that you have the
required prerequisite software installed. The BEA WebLogic Adapter for PeopleSoft
8 Release Notes is available at the following URL:

http://edocs.bea.com/wladapters/doc70/index.html

Understanding the Representation of Paths

Because the location of files in the WebLogic Integration environment depends on
options selected during installation and configuration, the conventions that follow are
used throughout to represent paths.

BEA_HOME represents the BEA Home directory specified for your WebLogic
installation.

For example, if you install the product in the default location on a Windows
system, BEA_HOME represents c:\bea.

WLI_HOME represents the root of your WebLogic Integration installation.

For example:

If you install WebLogic Integration 2.1 in the default location on a Windows
system, WLI_HOME represents c:\bea\wlintegration2.1.

domain is used to indicate the name of a domain.

In WebLogic Integration 2.1, preconfigured domains (bpmdomain,
eaidomain, wlidomain, and samples) are created as subdirectories of the
WLI_HOME\config directory. Therefore, domain may be used to represent
the root of a preconfigured WebLogic Integration 2.1 domain as follows:

WLI_HOME\config\domain

DOMAIN_HOME represents the complete path to the root of a domain.
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Step 1. Obtaining the BEA WebLogic Adapter for PeopleSoft 8
For example:

If you install WebLogic Integration 2.1 in the default location on a Windows
system, DOMAIN_HOME represents
c:\bea\wlintegration2.1\config\domain.

Note: WLI_HOME and BEA_HOME (italicized) also represent the corresponding
Windows and UNIX environment variables. For example, the literal
interpretation of WLI_HOME is %WLI_HOME% for Windows and $WLI_HOME for
UNIX.

Unlike WLI_HOME and BEA_HOME, DOMAIN_HOME is not an environment
variable that is set by default in the WebLogic Integration environment.

Step 1. Obtaining the BEA WebLogic Adapter 
for PeopleSoft 8

The BEA WebLogic Adapter for PeopleSoft 8 is packaged as an EAR file
(BEA_PEOPLESOFT_1_0.ear). You can obtain the software on CD or download it
from www.bea.com.

Note: At the time of publication of this document, WebLogic Server 6.1 is unable to
explode RAR files (BEA Support CASE number 333672). Use an extraction
tool (such as WinZip) to extract the contents of the adapter EAR file,
BEA_PEOPLESOFT_1_0.ear, and add the location of the unpackaged objects
to the server’s classpath (see Step 2. Extracting JARs and Adjusting the
Classpath).
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1 Installing the Adapter for WebLogic Integration 2.1
Step 2. Extracting JARs and Adjusting the  
Classpath

Set the classpath using the procedure appropriate for your system:

Extracting JARs and Adjusting the Classpath for Windows

Extracting JARs and Adjusting the Classpath for UNIX

Extracting JARs and Adjusting the Classpath for 
Windows

To unzip the adapter JAR files and adjust the classpath on Windows, complete the
following steps:

1. Use WinZip (or another similar extracting product) to extract the
BEA_PEOPLESOFT_1_0.ear file to a directory of your choice (for example,
BEA_HOME\lib\PeopleSoft).

2. Copy the psjoa.jar from your PS_HOME Web directory to the directory into
which you extracted the BEA_PEOPLESOFT_1_0.ear file (for example,
BEA_HOME\lib\PeopleSoft).

The psjoa.jar file is the Java Object Adapter (JOA) shipped with your
PeopleSoft application. This file is required by both WebLogic Server and the
BEA Application Explorer. It can be found in your PS_HOME Web directory.

Note: The psjoa.jar file is release-specific. Each time you upgrade your
Peopletools release, you must obtain the current version of psjoa.jar,
shut down WebLogic Server, and replace the old psjoa.jar with the
current version.

3. If you are using PeopleSoft release 8.1x, copy the pstools.properties file
(which is also found in your PS_HOME Web directory) to the same directory as the
psjoa.jar file.
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Step 2. Extracting JARs and Adjusting the Classpath
4. Go to the root directory for your domain:

cd DOMAIN_HOME

Note: You must choose a WebLogic Integration domain that supports application
integration functionality.

5. Find the SetDomainTypeData.cmd file.

Here, DomainType is the type of the domain. For example, if your domain is
configured to support the development of solutions that employ the full range of
WebLogic Integration functionality, it contains the SetwliDomainData.cmd
file.

6. Update the SVRCP environment variable settings in the
SetDomainTypeData.cmd file.

Note: The SVRCP environment variable is used in the SetDomainTypeData
script to set the classpath for the java executable.

After the following line:

set SVRCP=%SVRCP%;%WLI_DOMAIN_HOME%\wlai

add the following JAR files, which are listed in the order required for the
classpath:

REM Set PeopleSoft 8 Adapter classpath

SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\ibi-edaqm.jar
SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\BEA_PEOPLESOFT_1_0.jar
SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\ibi-psoft.jar
SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\psjoa.jar
SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\xercesImpl.jar
SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\xmlParserAPIs.jar

REM For PS 8.1x, use PS_BEA_CI81.jar.
REM For PS 8.4x, use PS_BEA_CI84.jar.

SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\PS_BEA_CInn.jar

REM For PS 8.1x, add the location of
REM the pstools.properties file.

SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft

Here, BEA_HOME\lib\PeopleSoft represents the directory specified in step1.
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1 Installing the Adapter for WebLogic Integration 2.1
Extracting JARs and Adjusting the Classpath for UNIX

To extract the adapter JAR files and adjust the classpath on UNIX, complete the
following steps:

1. Use jar (or another similar extracting product) to extract
BEA_PEOPLESOFT_1_0.ear to a directory of your choice (for example,
BEA_HOME/lib/PeopleSoft).

2. Copy the psjoa.jar from your PS_HOME Web directory to the directory into
which you extracted the BEA_PEOPLESOFT_1_0.ear file (for example,
BEA_HOME\lib\PeopleSoft).

The psjoa.jar file is the Java Object Adapter (JOA) shipped with your
PeopleSoft application. This file is required by both WebLogic Server and the
BEA Application Explorer. It can be found in your PS_HOME Web directory.

Note: The psjoa.jar file is release-specific. Each time you upgrade your
Peopletools release, you must obtain the current version of psjoa.jar,
shut down WebLogic Server, and replace the old psjoa.jar with the
current version.

3. If you are using PeopleSoft release 8.1x, copy the pstools.properties file
(which is also found in your PS_HOME Web directory) to the same directory as the
psjoa.jar file.

4. Go to the root directory for your domain:

cd DOMAIN_HOME

Note: You must choose a WebLogic Integration domain that supports application
integration functionality.

5. Find the SetDomainTypeData.cmd file.

Here, DomainType is the type of the domain. For example, if your domain is
configured to support the development of solutions that employ the full range of
WebLogic Integration functionality, it contains the SetwliDomainData.cmd
file.

6. Update the SVRCP environment variable settings in the
SetDomainTypeData.cmd file.

Note: The SVRCP environment variable is used in the SetDomainTypeData
script to set the classpath for the java executable.
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Step 3. Configuring the WebLogic Integration Database for the Domain
After the following line:

set SVRCP=%SVRCP%;%WLI_DOMAIN_HOME%\wlai

add the following JAR files:

# Set PeopleSoft 8 Adapter classpath

SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/ibi-edaqm.jar
SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/BEA_PEOPLESOFT_1_0.jar
SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/ibi-psoft.jar
SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/psjoa.jar
SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/xercesImpl.jar
SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/xmlParserAPIs.jar

# For PS 8.1x, use PS_BEA_CI81.jar.
# For PS 8.4x, use PS_BEA_CI84.jar.

SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/PS_BEA_CInn.jar

# For PS 8.1x, add the location of
# the pstools.properties file.

SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft

Here, BEA_HOME/lib/PeopleSoft is the directory specified in step1.

Step 3. Configuring the WebLogic 
Integration Database for the Domain

If you have not already done so, you must create the WebLogic Integration database
tables for your domain. For detailed instructions, see “Configuring the Database for a
Domain” in Starting, Stopping and Customizing BEA WebLogic Integration, which is
available at the following URL:

http://edocs.bea.com/wlintegration/v2_1sp/config/index.htm
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1 Installing the Adapter for WebLogic Integration 2.1
Step 4. Replacing the xmltoolkit.jar File

The BEA WebLogic Adapters include a new xmltoolkit.jar file. You must replace
your existing WebLogic Integration xmltoolkit.jar file with the new JAR file.

To configure the new xmltoolkit.jar file, follow these steps:

1. Rename your original xmltoolkit.jar file to xmltoolkit.jar.old by entering
the commands appropriate for your operating system:

On a Windows system:

cd WLI_HOME\lib
rename xmltoolkit.jar xmltoolkit.jar.old

On a UNIX system:

cd WLI_HOME/lib
mv xmltoolkit.jar xmltoolkit.jar.old

2. Extract the xmltoolkit.jar file from the adapter EAR file into a temporary
directory.

3. Copy the new xmltoolkit.jar file (extracted in step 2) to the WLI_HOME\lib
directory for Windows or the WLI_HOME/lib directory for UNIX.

Caution: Simply replacing the xmltoolkit.jar file is not sufficient; you must also
make changes to the setenv and SetDomainTypeData scripts as
described in the following steps.
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Step 4. Replacing the xmltoolkit.jar File
4. Edit the top-level setenv script and make the appropriate changes for your
operating system:

On a Windows system, edit the WLI_HOME\setenv.cmd script.

Replace the line:

set WLICOMMONCP=

with

set WLICOMMONCP=%WLI_HOME%\lib\xmltoolkit.jar

On a UNIX system, edit the WLI_HOME/setenv.sh script.

Replace the line:

WLICOMMONCP=$WLI_LIB/wlicommon.jar

with

WLICOMMONCP=$WLI_LIB/wlicommon.jar:$WLI_HOME/lib/xmltoolkit.
jar

5. Edit the SetDomainTypeData script.

Here, DomainType is the type of the domain. For example, depending on the
configuration of your domain, locate and edit the SetwliDomainData.cmd or
SeteaiDomainData.cmd file.

On a Windows system:

For example, edit the DOMAIN_HOME\SetwliDomainData.cmd script.

Replace the line:

set SVRCP=%WLISERVERCP%;%CMNCP%

with

set
SVRCP=%WLI_HOME%\lib\xmltoolkit.jar;%WLISERVERCP%;%CMNCP%

On a UNIX system:

For example, edit the DOMAIN_HOME/SetwliDomainData script.

Replace the line:

SVRCP=$WLISERVERCP:$CMNCP

with

SVRCP=$WLI_HOME/lib/xmltoolkit.jar:$WLISERVERCP:$CMNCP
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1 Installing the Adapter for WebLogic Integration 2.1
Step 5. Updating the BEA License

The BEA WebLogic Adapter for PeopleSoft 8 cannot be used without a valid software
license. If you have downloaded the adapter for evaluation, you must obtain an
evaluation license as described on the adapter download page. If you have purchased
a license for the adapter, the license file is typically sent to you as an e-mail attachment.

When you have obtained a valid license for the adapter, update your license.bea file
by completing the following steps:

1. Save the license file that you obtained with a name other than license.bea, in the
BEA_HOME directory. For example, save the file as
peoplesoft_adapter_license.bea. Use this file as the
license_update_file in step 4 of this procedure.

Warning: Do not overwrite or change the name of the existing license.bea file.

2. Perform the step appropriate for your platform:

On a Windows system, open an MS-DOS session and go to the BEA_HOME
directory.

On a UNIX system, go to the BEA_HOME directory.

3. If it is not already included, add the JDK to your PATH variable by executing the
command appropriate to your system:

On a Windows system:

set PATH=BEA_HOME\jdk131_03\bin;%PATH%

On a UNIX system:

PATH=BEA_HOME/jdk131_03/bin:$PATH
export PATH
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Step 6. Deploying the Adapter Using the WebLogic Server Console
4. Merge the license update file into your existing license by executing the
command appropriate to your system:

On a Windows system:

UpdateLicense license_update_file

On a UNIX system:

sh UpdateLicense.sh license_update_file

Here, license_update_file is the name to which you saved the license
update file in step 1.

5. Save a copy of your updated license.bea file in a safe place outside the
WebLogic Integration and application installation directories.

Step 6. Deploying the Adapter Using the 
WebLogic Server Console

After the BEA WebLogic Adapter for PeopleSoft 8 is installed, it must be deployed to
WebLogic Server for your domain (for example, wlidomain). To configure and
deploy an adapter using the WebLogic Server Administration Console, complete the
following steps:

1. Start WebLogic Server.

2. Start the WebLogic Server Administration Console in a browser using the
following URL:

http://localhost:port/console/

Here, localhost represents the machine on which WebLogic Server is running
and port represents the listening port.

For example, http://localhost:7001/console/
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1 Installing the Adapter for WebLogic Integration 2.1
3. When prompted, enter the user name and password for the server.

Note: If you have not updated the default login, see “WebLogic Integration Users
and Passwords” in Starting, Stopping, and Customizing WebLogic
Integration at the following URL:

http://edocs.bea.com/wlintegration/v2_1sp/config/getstart.htm

The WebLogic Server Administration Console opens.

Figure 1-1 WebLogic Server Console

4. In the left pane, choose Deployments and then Applications from the navigation
tree.
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Step 6. Deploying the Adapter Using the WebLogic Server Console
The console displays the Applications window.

Figure 1-2 Applications Window

5. Click the Install a new Application link.

The console displays the Install or Update an Application window.

6. Click Browse to locate the application archive you selected during installation
(BEA_PEOPLESOFT_1_0.ear).
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1 Installing the Adapter for WebLogic Integration 2.1
Figure 1-3 Locating the Application Archive Window

7. Click Upload to upload the BEA_PEOPLESOFT_1_0.ear file.

The console displays the application files currently installed to indicate that the
upload is complete and the adapter file is deployed to WebLogic Server.

8. You can verify deployment by viewing the adapter configuration, as follows:

a. Choose Deployments and then Applications from the navigation tree.

b. Click the BEA_PEOPLESOFT_1_0.ear file link.
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Step 7. Adding the Administrative Server User Name to the Adapter Group
Step 7. Adding the Administrative Server 
User Name to the Adapter Group

A user group, adapter, is defined in each domain that supports application integration
functionality. Before you create an application view that employs the events or
services supported by an adapter, you must add the user name defined for the
administrative server to the adapter group.

Note: By default, the adapter group includes the user system. If the user name
defined for the administrative server is system, skip this step. For example, if
you are starting the server in a preconfigured domain, and you have not
modified the default administrative server login, you can skip this step.

To add the administrative server user name to the adapter group, complete the
following steps:

1. In the left pane of the WebLogic Server Administration Console, choose Security
and then Groups from the navigation tree.

The console displays groups currently defined for the domain.

2. Locate and click the link for the adapter group to display the group definition.
BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide 1-15



1 Installing the Adapter for WebLogic Integration 2.1
Figure 1-4 Group Definition

3. If the administrative server user name is not included in the Members list, enter
the user name in the Add Users field.

4. Click Apply to add the user name to the group.

The name is added to the Members list.

Next Steps

If you have not already installed the BEA Application Explorer, install it now. See the
BEA Application Explorer Installation and Configuration Guide.

When you have successfully deployed the adapter and installed the BEA Application
Explorer, you can log on to the WebLogic Integration Application View Console to
create application views that employ events and services supported by the BEA
WebLogic Adapter for PeopleSoft 8. For more information, see the BEA WebLogic
Adapter for PeopleSoft 8 User Guide.
1-16 BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide



CHAPTER
2 Installing and 
Compiling the 
Component Interfaces

This section describes how to install and compile the component interfaces. It includes
the following topic and installation steps:

BEA WebLogic Adapter for PeopleSoft 8 Component Interfaces

Step 1. Making Component Interfaces Available to PeopleSoft 8

Step 2. Configuring Component Interface Security

Step 3. Testing the Component Interfaces

Step 4. Modifying the Classpath of the Machine that Runs BEA Application
Explorer

Note: For more information about the BEA Application Explorer, see the BEA
Application Explorer User Guide.
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2 Installing and Compiling the Component Interfaces
BEA WebLogic Adapter for PeopleSoft 8 
Component Interfaces

BEA delivers two component interfaces as part of the BEA WebLogic Adapter for
PeopleSoft 8. These component interfaces are used in conjunction with the BEA
Application Explorer to facilitate the creation of schemas for events and services. The
BEA Application Explorer uses the delivered components for metadata information to
build schemas.

For the delivered component interfaces, you must perform the following steps:

1. Make the delivered component interfaces available to PeopleSoft 8.

2. Configure the component interface security.

3. Test the component interfaces.

4. Modify the classpath of the machine that runs BEA Application Explorer.

Step 1. Making Component Interfaces 
Available to PeopleSoft 8

The supplied component interfaces are delivered via a PeopleSoft project. For
PeopleSoft release 8.1x, the project is called BEA_CI_81 and is contained within file,
BEA_CI_81.zip. For PeopleSoft release 8.4x, the project and file name are
BEA_CI_84 and BEA_CI_84.zip, respectively. The zip files are located within the
BEA_PEOPLESOFT_1_0.ear file. You can extract it using any extraction software.
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Importing Project BEA_CI_81 or BEA_CI_84 to 
PeopleSoft 8

The following steps describe how to import the BEA_CI_81 or BEA_CI_84 project to
PeopleSoft 8.

1. Unzip the BEA_CI_81.zip or BEA_CI_84.zip file to a directory of your choice.

The unzip process will create its own subdirectory.

For example, if you extract it to c:\temp, a subdirectory called BEA_CI_81 or

BEA_CI_84 is created in c:\temp.

2. Launch the PeopleSoft 8 Application Designer in two-tier mode.

3. From the File menu, choose Copy Project from File.

Note: In PeopleSoft release 8.4 or higher, from the Tools menu, you must choose
Copy Project→From File.

4. Navigate to the original directory to which you unzipped the file.
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Figure 2-1 Application Designer Window - Release 8.1
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Figure 2-2 Application Designer Window - Release 8.4

The Application Designer displays the Copy Project From File dialog box.
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Figure 2-3 Copy Project From File Dialog Box - Release 8.1
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Figure 2-4 Copy From File: Select Project Dialog Box - Release 8.4

5. Click Copy (in release 8.1) or Open (in release 8.4) to open the Copy dialog box.

Note: Although the following figures illustrate PeopleSoft release 8.4, the
corresponding steps are accurate for releases 8.1 and 8.4.
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2 Installing and Compiling the Component Interfaces
Figure 2-5 Application Designer - Copy From File Dialog Box

6. Make sure that all the objects listed under Object Types are highlighted and click
Copy. The Application Designer displays a copy ended message to indicate
successful completion.
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Figure 2-6 Application Designer - Copy Ended Message

7. Build the views in the project by choosing Build→Project.

The Build dialog box opens.
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Figure 2-7 Application Designer - Build Dialog Box

8. Select Create Views in Build Options. Select your site’s customary option in
Build Execute Options. (In the previous figure, we have selected Execute SQL
now.)

9. Click Build.

The Application Designer displays a Build Progress status window.
2-10 BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide



Step 1. Making Component Interfaces Available to PeopleSoft 8
Figure 2-8 Application Designer - Build Progress Dialog Box

Notice that there are zero errors and zero warnings.

You may use your native SQL Tool to view the records from the generated view
to ensure that they have been created correctly.

10. If the view has not been generated correctly, click Close and double-click the
SQL Build log statement.

The PSBUILD log file displays.
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Figure 2-9 Application Designer - PSBUILD Process Log File

11. If you encounter problems, check the Build settings options by choosing
Build→Settings.
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Figure 2-10 Application Designer - Build Settings Dialog Box

Depending on the application server database for PeopleSoft 8, some databases
may require the Tablespace name. Consult your PeopleSoft 8 database
administrator for more information regarding this function.
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Step 2. Configuring Component Interface 
Security

Before the delivered component interfaces can be used, security for each component
interface must be set. Component interface security should be set for each distinct
Permission List belonging to users who are going to use the product being installed.

You must set the security for all delivered component interfaces in the project. In
PeopleSoft release 8.1, you may set security in 2, 3, or 4-tier mode; in release 8.4 and
higher, you may set security 4-tier mode. Regardless of your release level or interface,
you must follow the same steps. The figures in the following steps show how to
configure component interface security for PeopleSoft release 8.4 in 4-tier mode.

1. Choose PeopleTools→Security→User Profiles→Permissions & Roles→
Permission Lists.
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Step 2. Configuring Component Interface Security
Figure 2-11 Permission Lists Window
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2 Installing and Compiling the Component Interfaces
2. Click Search and select the relevant Permission List.

Figure 2-12 Searching for Permission Lists

3. Click the right arrow next to the Sign-on Times tab to display the Component
Interfaces tab.
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Step 2. Configuring Component Interface Security
Figure 2-13 Finding the Component Interfaces tab

4. Click the Component Interfaces tab.
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Figure 2-14 Component Interfaces Window

5. Click the + button to add a new row to the Component Interfaces list.
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Step 2. Configuring Component Interface Security
Figure 2-15 Component Interfaces List

6. Enter or select the BEA_CI_ATTRIBUTES component interface and click Edit.
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Figure 2-16 Component Interface Permissions Window

7. Click Full Access (All) to set the Get and Find methods to Full Access.

8. Click OK.
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Step 3. Testing the Component Interfaces
9. Repeat steps 5 through 8 for the BEA_CI_MESSAGES component interface.

10. Scroll down to the bottom of the Component Interfaces window and click Save.

Step 3. Testing the Component Interfaces

All BEA delivered component interfaces must be tested individually before continu-
ing. Using Application Designer, open each component interface individually and test
the component interfaces BEA_CI_ATTRIBUTES and BEA_CI_MESSAGES by executing
the Find and Get methods.

1. Open the BEA_CI_ATTRIBUTES Component Interface.

2. Choose Tools→Test Component Interface.

The Component Interface Tester dialog box opens.
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2 Installing and Compiling the Component Interfaces
Figure 2-17 Component Interface Tester Dialog Box

Note that the Create New option is disabled. This is because the Add method is
not applicable to this component interface.

3. Click the Find button. Entries for the underlying component are displayed.

A message may appear stating that display is limited to a certain number of
entries; this is not a problem.
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Step 3. Testing the Component Interfaces
Figure 2-18 Component Interface Tester - Find Results Window

4. Highlight one of the lines with its corresponding key in the Find Results window
and click the Get Selected button.

The relevant data for the selected key is displayed.
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2 Installing and Compiling the Component Interfaces
Figure 2-19 Component Interface Tester Window

If this window is displayed, the component interface has been successfully tested
for the Find method.

5. Click the Get button. For the Get method, an existing key must be entered.
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Step 3. Testing the Component Interfaces
Figure 2-20 Component Interface Tester Window

The exposed properties for the key that is entered are returned.
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Figure 2-21 Component Interface Tester - Results Window

If this window is displayed, the component interface has been successfully tested
for the Get method.

6. Repeat this process for each of the delivered component interfaces.
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Step 4. Modifying the Classpath of the Machine that Runs BEA Application Explorer
Step 4. Modifying the Classpath of the 
Machine that Runs BEA Application Explorer

The BEA Application Explorer requires the same set of jar files as required by the
WebLogic Integration Server. These are the jar files that were extracted in Step 2.
Extracting JARs and Adjusting the Classpath in Chapter 1, “Installing the Adapter for
WebLogic Integration 2.1,” and put in the classpath in the SetDomainTypeData.cmd
file.

However, unlike the WebLogic Integration Server, no changes in command files are
required. It is sufficient to simply place these files in the lib directory of the BEA
Application Explorer. These files include the PeopleSoft Java Object Adapter file
(psjoa.jar) and pstools.properties (for release 8.1)

The psjoa.jar and the pstools.properties change with each release. For information
on replacing these files, see the warning at the end of the section called Step 2.
Extracting JARs and Adjusting the Classpath in Chapter 1, “Installing the Adapter for
WebLogic Integration 2.1.”
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CHAPTER
3 Installing and 
Configuring the BEA 
TCP/IP Message Router

To enable PeopleSoft 8 to send an XML event document to the WebLogic
environment using TC/PIP, you must load the required software on the PeopleSoft 8
system and configure the PeopleSoft 8 application gateway. This section describes
how to do so, and includes the following topics:

Installing BEA TCP/IP Handler for PeopleSoft Release 8.1

Installing BEA TCP/IP Target Connector for PeopleSoft Release 8.4 and Higher

Installing BEA TCP/IP Handler for 
PeopleSoft Release 8.1

This topic provides instructions for installing the BEA TCP/IP Handler for PeopleSoft
release 8.1. It includes the following steps:

Step 1. Extract and Install the BEA TCP/IP Handler

Step 2. Configure the BEA TCP/IP Handler on the PeopleSoft 8 Gateway Server
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3 Installing and Configuring the BEA TCP/IP Message Router
Step 1. Extract and Install the BEA TCP/IP Handler

The BEA TCP/IP Handler software for PeopleSoft release 8.1 is in the
TCPIPHandler81.jar file and is located within the BEA_PEOPLESOFT_1_0.ear
archive. To extract the .jar file from the .ear archive, use WinZip or a similar
extraction tool. Once extracted, you must port the file to the platform where the
PeopleSoft 8 gateway Web server is located, place it in the servletclasses directory
under the PeopleSoft Web server, and extract the embedded class files.

The following example illustrates an installation on a UNIX SUN/Solaris machine
where the PeopleSoft 8 application server is running:

1. Log on to the UNIX machine with the proper PeopleSoft 8 ID and permissions.

2. Navigate to the PeopleSoft 8 Web servlets directory. This may vary between
releases and may change according to you r Web Server, but typically it is:

$PS_HOME/webserv/servletclasses

3. Issue the jar command to extract the class files required by PeopleSoft.

This is a sample command:

jar -xvf /tmp/TCPIPHandler81.jar

The following output would be displayed:

$ jar -xvf /tmp/TCPIPHandler81.jar
created: META-INF/

extracted: META-INF/MANIFEST.MF
extracted: psft/pt8/tcphandler/TCPIPHandler81$Entry.class
extracted:
psft/pt8/tcphandler/TCPIPHandler81$HandlerEntry.class
extracted:
psft/pt8/tcphandler/TCPIPHandler81$PublicationHandler.class
extracted: psft/pt8/tcphandler/TCPIPHandler81.class
$

Notice that the files are placed in a new directory, tcphandler, under the
psft/pt8 directory structure.
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Installing BEA TCP/IP Handler for PeopleSoft Release 8.1
Step 2. Configure the BEA TCP/IP Handler on the 
PeopleSoft 8 Gateway Server

To configure the BEA TCP/IP Handler software, perform the following steps:

1. Launch the PeopleSoft 8 configuration servlet interface (server gateway). This is
typically under:

http://serverURL/servlets/gateway.administration

Figure 3-1 PeopleSoft 8.16.03 Handler Directory Window

2. Click the Add handler button.
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3 Installing and Configuring the BEA TCP/IP Message Router
The Add Handler window opens.

Figure 3-2 Add Handler Window

3. In the Handler class field, enter the name of the BEA PeopleSoft 8 handler class:

psft.pt8.tcphandler.TCPIPHandler81

4. Click Save. The Handler displays the following status window:
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Installing BEA TCP/IP Handler for PeopleSoft Release 8.1
Figure 3-3 Handler Status Window

The handler appears in the Handler directory list, but the Status reads Not
loaded.

5. Click Load to activate that handler. Once loaded, the gateway servlet loads the
specified Java class in memory after searching the machine Classpath.

The Status column should read Loaded successfully. If you receive a
ClassNotFoundException error as the status, the gateway servlet did not find the
particular Java class you indicated. Make sure that the Classpath is correct. If
necessary, you may need to restart your Web server.
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3 Installing and Configuring the BEA TCP/IP Message Router
During production, you may want to temporarily deactivate a handler. To
deactivate a handler, click the Unload button. This removes the particular
handler from the list of active registered handlers to which the gateway servlet
can publish messages.

If the .jar file was placed in the correct PeopleSoft 8 application directory on the
correct application server, the following screen opens:

Figure 3-4 Load Handler Window

6. Click the Configure button to switch to the lookup table view.
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Installing BEA TCP/IP Handler for PeopleSoft Release 8.1
Figure 3-5 TCPIP81 Handler Directory Window

7. Click the Add a TCPIP81 node button.

The TCPIP81 Handler window opens.

8. In the Node Name field, enter the name of the node you want to add, such as
BEA_MSGNODE.

9. In the Host Name field, enter the name of the host machine of the WebLogic
Integration server.

10. In the Port field, enter the TCP port that was entered during the adding of the
application view event.
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3 Installing and Configuring the BEA TCP/IP Message Router
11. In the Trace Directory field, enter the directory where the trace file should be
created in case the handler experiences some problem with the message delivery.

Figure 3-6 Add TCPIP81 Handler Window

12. Click Save. The BEA Handler Directory window opens.
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Installing BEA TCP/IP Handler for PeopleSoft Release 8.1
Figure 3-7 TCPIP81 Handler Directory Window With Node

The BEA TCP/IP Handler configuration is now complete.
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Installing BEA TCP/IP Target Connector for 
PeopleSoft Release 8.4 and Higher

The BEA TCP/IP Target Connector software for PeopleSoft release 8.4 is in the
TCPIPTARGET84.class file and is located within the BEA_PEOPLESOFT_1_0.ear
archive. To extract the .class file from the .ear archive, use WinZip or a similar
extraction program. Once extracted, you must port the file to the platform where the
PeopleSoft 8 gateway Web server is located and place it in the PS server target
connector directory. This will be located in different places depending on your web
server. Typically, these will be:

For WebLogic,

c:\bea\wlserver6.1\config\peoplesoft\applications\PSIGW\Web-inf
\classes\com\peoplesoft\pt\integrationgateway\targetconnector

For WebSphere,

c:\websphere\AppServer\installedApps\peoplesoft\PSIGW\Web-inf\
classes\com\peoplesoft\pt\integrationgateway\targetconnector
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Installing BEA TCP/IP Target Connector for PeopleSoft Release 8.4 and Higher
 How to Create a Gateway

1. Click PeopleTools → Integration Broker → Gateways.

Figure 3-8 Gateways Window

2. Find the Local Gateway and enter the URL in the Gateway URL field.

This URL is usually set during installation.
BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide 3-11



3 Installing and Configuring the BEA TCP/IP Message Router
Figure 3-9 Gateway URL Window

3. Click the Load button. The Connector Properties are displayed. These are
predefined during the Integration Broker installation.
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Installing BEA TCP/IP Target Connector for PeopleSoft Release 8.4 and Higher
Figure 3-10 Connector Properties Window

4. Click OK. The TCPIPTARGET84 connector is included in the Connectors list.

5. Enter the Gateway URL. The following window opens.
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3 Installing and Configuring the BEA TCP/IP Message Router
Figure 3-11 PeopleSoft Integration Gateway Window

The Gateway is now configured.
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